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System Requirementsfor Classtalk

* Instructor’s Macintosh Computer:
Can be any model with the ability to handle dual monitors.Some
macs come with this built in others require an additional video
card. Check to seeif thereisavacant slot where a second video
card can be added. Finding a second video card for older Macs
may be a problem, many are no longer manufactured. Cardsfor
Macs with PCI type dlots are easily found and inexpensive.

* Memory required: 16Megabytes minimum,

 Disk spacerequired: requires approximately 6 Megabytes
initially,

» System Software: For the latest Classtalk release 2.0 we
recommend that you have System 8.0 or greater installed. We
do have versions of Classtalk that run on older operating
systems available. Talk to us about your needs.

* Instructor’s Display(s): At least a 640x480 color display
compatible with Macintosh Analog RGB output. Sometimesiit is
desirable to have a second display so that you can easily see
what the students see.

» Projection Device: Useacolor LCD projector, an LCD Panel
or a Scan Converter w/ TV. The projection device you choose
should be able to handle aresolution of at |east 640x480.

NOTES. . .

We recommend a Blue and White G3 in a rollable
instructor’s station or a G3 laptop works great-- you
can take it back to your office or home to peruse
your data or make up new questions for next time.
The G3 lombardo laptop comes with the ability to
handle dual monitors and TV&S-video out. This
means if you ever want to use a television for your
projection device you won't need a scan converter.

Ifyou plan to use a lot of other programs along with
Classtalk, you will want more thani6M of memory.
We're quite happy with 16M for most classroom use.
Classtalk runs fine with RamDoubler(tm). but don't
expect speedy performance if you're pushing the
limits of doubled RAM.

What you actually need in disk space depends on
how much you will be using Classtalk, and how big
your class is. With a class of 100 students, expect to
consume about 50K per question. The amount scales
with class size. Classtalk warns you if free disk space
Jalls below 1M.

Conflicts? Classtalk uses the serial port to communi-
cate with the network. If you have other software
that uses that port (e.g. modem-ware), you will want
to disable it while using the Classtalk network, but
you should have no problems in “office mode”
(without the network). Also, if you only have one
sertal port, make sure that Appletalk is either
switched off or directed to another port.

Find out what resolution you will be projecting to. If
you have a second display it should be able to handle
at least that resolution.

A device for projecting graphics is very important.
Showing the students the histogram after each task
keeps them interested.
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A good way to arrange CT files...
Classtalk afolder containing the following...

CT 2.x the Classtalk application program

Instructor’sList atext file with passwords for authorized
instructor-users. Use SimpleText or TeachText to custom-edit
thisfile for your own use, or just use the default password ‘R’.
Classroom.config a specia text file containing layout informa-
tion for the classroom. Please select one that closely matches
your classroom from selection depicted in Appendix A
Classroom preferences a specid file potentially containing
instructor customizations of the Classtalk program operations &
interface.

Task Template a Task file that contains generic tasks or “tem-
plate”’ tasks that you can use to speed up creating new tasks.
Individual questions or question setsin the Task Template file
are accessed from the “ Task fields” window or QS settings
window.

Quick QnsaTask file that contains generic tasks for you to use
“off-the-cuff” in class. Choose these questions or question sets
from the “Quick Qn” Menu.

DEMO CLASS thisis sample classfile for you to explore.
Throw it out when you get tired of it.

SF for DEMO CLASS thisfolder contains sessions for the
DEMO classfile. You can explore. what happened in the DEMO
sessions by opening them with “ Open SessionFile”.

SP For DEMO CLASSI s afolder that contains student pics for
studentsin DEMO CLASS. If you click on astudent in the
room view you can see their picture.

DEMO CLASS.dbg Thistext file contains alog of unusual
network activity, which is helpful for troubleshooting network
difficulties.

*Tasks* thisfolder contains some samples of tasksin afew
different taskfiles. It'sagood ideato put your own taskfilesin
this folder becauseit’'s so easy to find.

Onceyou’ve started your own classfile,

you will have files and afolder like these in your Classtalk
folder...

PHY 103 F' 99

SF for PHY 103 F 99

PHY 103 F'99.dbg
These will contain the information about your class over the
course of a semester or quarter.

Other important files& folders
» CT Network Tools: afolder containing...

testnet A an application program for independently testing the
CT network

sna updater an application for uploading network software into
the network boxes' memory chips.

SNA V2.6HEX the actua code used by the network boxes
during Classtalk operation.
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Notes:...

Classtalk uses quite a number of different files. It
needs to be able to find the files when it is starting
up. Since more than one instructor may use a
Classtalk (for different courses) on the same
Macintosh, you may want to separate course-
specific files into separate folders. For each course
you teach, we think you will want its “classfile” and
sesston folder to be located within an appropriately
labeled course folder. You may also want a
classroom configuration file if other instructors use
different classrooms.Other template & confiy files
can be customized and kept in your course folder as
well.

Customize the task template file by opening it as a
task file and adding, deleting or modifying tasks as
you see fit.

Customize the Instant Question file as described
above for the Task Template file.

We suggest you choose a name for your Classfile
that indicates unambiguously the course and
semester. The Sesston folder and Debuyg files are
named automatically based on the Classfile name.

TI USERSNOTE: 7%ese files are not applicable to the
BLACK BOX verston of the Classtalk network.
And so may not be included on your diskette.
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Trying out Classtalk...
» Setting up: Make sure you have loaded the appropriate files into

a suitably named folder
(Seep.2 for alisting of files & folders).

If you have an Office Network or areworking with a class-
room CT Network...

Connect the serial cable between your Macintosh’s Serial port
(marked with atelephone icon) and the Classtalk network box.
Connect the box to it’s power supply THEN plug the power
supply into the an AC outlet. Power-on AFTER cabling!

For thisQuickStart Session, we're assuming you are using
Classtalk with a network so you can try out how the system really
worksin class.

I
E’@ Starting up the DEM O Class...

Double click on the Classfile Icon labeled “DEMQO” . When you
have a classfile for your own class, you can start Classtalk for
that class by double clicking on its Classfile icon.

Welcometo Classtalk (a Dialog Box)

We' ve provided atemporary password for your use. Type the
letter R (capitalized)in the password field and click on “OK” (or
press <Return>) to proceed with the Classtalk session.

Open Login In amoment, you will be asked if you want to open
Login (so members of the class and can connect to the network
and answer questions.) Choosing “Allow new students” will
enable “new students’ to create their own new accounts in the
DEMO Classfile.

Setting the L ogin timer Next the timer window will open so
you can choose how long to leave “login” open. The default is
20 min, which is usually enough (except on the first day, when
you may wish to leave it open longer). Set the time and click
“START” or press[Return].

Logging in students You should now see a classroom laid out in
the main window. Seat locations are represented by “empty seat’
icons.

Classview popup menu

Room [&] | Use the “ Classview popup menu”

to select “Roll list” in order to see who's registered in this

DEMO class. Students who are aready on the Roll can login by
entering their seat location, handle, and password (for HP95s,
also the Hardware | D#).

Once you have three or four DEMO students logged in, you
should try sending some tasks to get a feeling for the students
view of classtalk aswell asthe instructor’s view.
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Notes...

This “connect-then-power-up” sequence minimizes
the chance of damaging etther the computer or the
Classtalk network with transient shorts or voltage
spikes.

If you don't have a network to try out, you can
proceed, but will be unable to Login students, have
them send in answers & view feedback, or review
thetr responses to an “Active Task”. Otherwise
things should work OK.

Eventually, you will have a separate classfile for
every course-section that you teach using Classtalk,
unless the exact same students are taking more than
one course from you.

In this dialog, be sure to check “office mode” if you
are operating without a network-- otherwise the
program will spend a minute watting for the
network to respond.
Eventually you will want to edit the password file
“Instructors List” to add a more secure password.
Ifyou don’t have a network...
The “Task list” window should be open before you,
showing you the currently selected task called
“Question_1". This is a blank task created in a
default Taskfile named “Untitled 17 This is a great
Dplace to begin making new tasks. Or you can open a
taskfile and edit some previously composed task.
We suggest you turn to that section of the
Quickstart manual at this time, or learn to review
“Records” of past sesstons.

As students “Login,” these seats will darken, and
you can click on them to pop up a small box of
information about that particular student.

Refer to the Student User’s Guide for your type of
Student device for instructions on “ logging in”.

Up to four students can share a single student
computer. Each student logs in with his/her own
seat, handle and password. The instructor chooses
whether students must answer individually, or was
a group (and whether dissent is allowed for group
answers.)
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What isa“ Task” ? Notes...

ATaskisaquestion or set of questions. e Most likely in any one class session you will want

to ask several Classtalk questions. You might
* “Questions’ arethe raison d' etre of Classtalk. Classtalk uses atype gather questions that have been prepared ahead of

of document called a“ Taskfile” which may have just asingle time in a single taskfile so they e easy to get to.
question, but more likely contains a group of five to ten questions
with some common linking theme--topic, concepts, scenario, etc.

Using an Existing Task

» Getting & Previewing atask
To use a prepared question, you must first open the taskfile that
contains it, and then select the question (from the list of questions
in thefile) by clicking on the Question title, or by choosing the
Question from the popup menu of Question titles.
There are several windows for viewing the details of a Question,
Here are step-by-step instructions...

* Opening a Taskfile
Use the main Files menu to select “ Open Taskfile”
i.e Files->Taskfiles->Open Taskfile
Use the “file selector” dialog box to choose ataskfile: e.g. open
the folder called “* Tasks*” and locate the taskfile “DemoTasks’.
Double click on the name “DemoTasks’ to open the taskfile.

e From the “New” menu in this mode panel, you can
create a new question anytime, and it will

» Selecting “ New Tasks” Mode automatically be added to whatever Taskfile you

are working in.

Mode Panel

Click on the bottom left “Mode Panel” to switch the Classtalk
program into the “New Tasks” mode. Use this mode whether you
are selecting atask to send to your class, or are creating a new

task, in class or out.  Questions can be reorganized in the List view by
dragging them up or down the list. You can also
copy selected tasks. from one taskfile and paste
them in another.

« Different views of a“ Question”

LIST

i—|Showsalist of all Qnsin thetaskfile;

Pressthe “List” tool-button when you want to see alist of al the
titles of questions in ataskfile of new tasks (or in the records of a
particular session).

Shows the Qn screen (will be projected)

Press this tool-button when you want to see (or edit) the selected
Qn’s screen that will be projected for the whole class to see (on
TV or LCD pandl).

gg Shows Qn info fields (range, feedback etc.)

Press this tool-button if you want to see or edit the Qn’'s data
fields (that contain question and answer specific settings and
data). Thiswindow shows the text that students read on their
units (hot text and answer-specific feedback), question type (MC,
Nu, Wd, Tx and Algebraic) and bin specifiers.
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e TheTask Cycle... Notes:
Once you decide to use atask, thereis a series of stagesit goes - This cycle is so universal that we've designed an
through before you and the class are finished with it. We call ;‘ZWO@[C[Q ”f:‘aﬁf;e, 50[ [W}l C[agpmg’“f{ss l;/;z"ougﬁ

; « " oo : 1s cycle automatically just by pressing the

this the task cycle” sinceit may lead back to another new [Return] key or by clicking repeatedly on a single
question. Tool-strip button which changes meaning as you
1) First a“new task” is sent to the students' computers, becom- move through the cycle. Of course you can break
ing an “ active task” out of the cycle anytime.

2) as soon as you start the task timer, the students may answer,
Usually you will want to see their answers comein so you see

how they’re doing.

3) You will want to see how the class did in aggregate. This

“Analysis’ isin the form of ahistogram, or alist of answers.
4) your students will appreciate seeing the “Analysis’ too, to see

how they stand in class.

5) After discussion, perhapsyou’re ready for another task.

Clicking “Done” or sending another task moves the “Active’
task into “Records’ where you can find it later should you need

it.

« Sending atask
There are three stepsin launching atask...

1) Select the task or question set by clicking on it in the task list

window, or selecting it in the “New Tasks’ mode panel popup

menu);

2) |m| Send” the task out over the network using the « “Sending”the Task screen so you can go over the

question with the class before they begin to answer

“Send” button in the tool strip; “

3)| B:82:88 | Set up thetimer so the task will run for a

reasonable amount of time (use the preset times, typein, or use

the arrows to increase or decrease the Qn time.While you're at
it, double check Grouping and Feedback modes (see below);

4) Start thetimer running so that the students can

seethe “Hot text” on their computers and begin sending in their
answers.

« Modesfor answering

Grouping: Classtalk allows you, the teacher, to decide how you

want your students to answer the active question or questions.

Answers may be Individual, “Group” and “ Group w/ Dissent”

GEDQ

Use this button to set the grouping mode, or use the timer

controls: [<] Grouping

(<] with dissent?

Feedback: Feedback can be disabled, or enabled.
Normally FB is shown after the timeis up, but you may choose

to make it available immediately after answering. Use tool
button, timer setting, or menu (under Task) to set the feedback

mode you desire.

Irg- [] FeedBack is al ...
tool button 7 |mpymediately? ntmen
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» Automatic “binning” of student answers
As student answers arrive at the teacher’s computer they are

categorized-- sorted into either predefined bins, or automatically

Notes...

created bins. Each bin has a designated color code, so students

who's answers fall into the same bin are shown in the same color.
Bin Key Pand (to theright of the main window) shows the color

code for the various bins along with a descriptive field (e.g.
“range’

-

Hange

Bin key & popup menu

1

Use the popup menu to select which of the bin-specific fields to
show along with the color code (the choices are Range, Feedback,

Notes, & Score)
Autobin & Question Set Bin Key is dightly different from

preset-bin key. These bins are created automatically from the

student answers.

~ 1 #3~2#1 F.yy
uestion Set bins
~ ] #1~ 2 #1 1s]H] © , _
e Inthis example,there were two questions in the
Question set bins group students by their series of answersto al question set. Twenty seven students sent in
the questions in the question set. The key shows question number answers to Qn 1 that fell into Qn 1’s 3rd bin, along

and bin number for each question in the set, and tallies the number with answers to Qn 2 that fell into Qn 25 first bin.

of students who answered with this set of answers.

» Monitoring incoming responses

“ Classview” showsindividual responses.

“Classview” isaview of individual datalaid out either in a

representative “room” (showing answers by seat location) or in a

list showing student names and answers, called “List & Answrs’.

Room [&] | Classview popup menu

Use the “ Classview” popup to change between “Room” and “List
& Answrs’.

* Analyzing Classresponse

HHHL'SE or@“ Analyse” & “AnlZ’ buttons

Use the“Analyse’ autocycle button or the “Anlz” button in the

toolstrip to bring up a summary histogram of the class' responseto

the question.

Answers v 2l

Analysis controls

“ZIn v Timel[=l

Use the analysis popups to choose among various analysis

displays. Source settings let set different sources for up to two
simultaneous analyses. e Projecting the class response help the students

e SharingtheAnalysis (or other screens) appreciate how the class response is divided, ad
where their own answers fit in the whole picture.

F‘HD-J ECT : or » Pij ect” & Pij " buttons Most students really appreciate seeing this screen.

“Project” puts the analysis on the 2nd monitor
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Notes:
On to the next task

or e “Done” also clears the question and feedback

Jrom the students’ computers, so there is nothing
Once you and the class are finished with an active task-- they’ve for them to look at or do unless login is still open.

looked at their feedback and seen the Analysis histogram, and you
all have puzzled out the meaning of different answers-- use the
“Done” button to transfer thistask into “Records’ and get ready for
another task.

“Quick Questions’ for unanticipated queries

In class, when you have a simple question and you want a quick
answer try using the “ Quick Qn” menu to select a generic question

from the Quick Qn Taskfile. We've provided a number of useful * Ifyou have a favorite type of generic question
. . . . . that we haven't provided, you can edit the Quick
generic questions: true-false, yes-no, multiple choice(A..D) and . ;

. . . ‘ Qn Task file just as you can edit any other task
various others which you can use with an overhead slide, a board file. This will give you instant access to your own
drawing or just averbal question. All you haveto do is choose the “Quick Questions”.
question and set the time. e “Quick Ons” do not show question-specific text

either on the projector or on the student devices.

e . L. . You, the teacher, must “talk” the question, or
M odifying Existing Questions write it out.

It is easy to modify a question to make it better fit your needs. The
graphical objects and text that are projected can be moved, re-
shaped, or edited using graphical toolsin the “Task screen win-

dow”. “Hot text” and feedback that the student receive on their
computers is editable in the “ Question fields window”

e The “Header” of a QnSet only shows only special

tool button bri ngs up the Task Screen QnSet controls. You can edit individual questions
within the QnSet by selecting them individually.

Press this tool-button when you want to see or edit the selected

Qn’'s“Task screen.”

IE The pointer tool is used to select graphical or text objects and

to move or resize them (by dragging one of the corner “handles’).

Clicking with the pointer tool within an already selected text region

places the cursor within the text for editing.

gg tool button brings up_Question Fields

Press this tool-button if you want to see or edit the selected Qn's

“Question fields” such as“title”, “time”,"“hot text”, answer-specific

“feedback”, “question type” “bin range(s)”, “prompt”, “bin

score(s)” and the various descriptor & note fields.

Tarpe

changing “ Type” replaces bin fields

WARNING:every question hasa“type” If you change a

question’s“ Type” you will lose the information in the bin fields « Creating a “New” question will automatically
open the “Question Fields window so you can

Creating a New Ouestion (On begin entering the field information you need.

[apply template |
N popup menu
e Apply Template” lets you start from a pre-
w defined question from the “Task template” task
E ﬁ[e

Use the “New” popup in the “New Tasks Panel” to create a new Qn,
Question set, or Slide
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Working with Question Fields

“Question fields” contain vital details that put the powerful
computer analysisto work for you.

Press this tool-button if you want to see or edit the

“Question fields” for the selected Qn: “question type”, “title”,
“time” " hot text”, answer-specific “feedback”, “bin range(s)”,
“prompt”, “bin score(s)” and various descriptor & note fields.

Choosing a question “ Type.”

Type
“Qn Type” field selector pop-up...

Use the popup menu to select the desired question type. Currently,
Classtalk supports four types of questions:

1) Multiplechoice (M C) questions are answered with asingle
character. You may use aseries (A,B,C...E etc. or 1, 2, 3...9) or
you may use mnemonic characterse.qg. T & F (true & false) or Y
and N (yes and no).

2) Numeric (Nu) questions are answered with a number entered
inavalid numerical syntax. 0, 1, 2, 3.14, .00375, 6.02e23 (i.e.
6.02 times 10 to the 23rd).Valid numbers are between +1 e £38.
3) Word (Wd) questions are answered with aword or words
totalling up to 40 characters. Caseis not significant. A few
characters are not allowed--

3) Text (Tx) questions are answered with words, word lists,
sentence, paragraphs or small essays. Currently Tx answers must
be less than 2,400 characters (about 1 full typewritten page). Case
isnot significant. A few characters are not allowed--

4) Algebraic (Al) questions are answered with an algebraic
expression (up to 38 characters). Operations supported are
addition (+), Subtraction (-), multiplication (*), division(/),
grouping (parentheses), integer powers(e.g. 2, *3

Caseis not significant. A few characters are not allowed--
Classtalk supports multicharacter variable names A1, Pi, Tau
areall OK.

Implied multiplication is supported only for parenthetically
grouped terms...

A*(B-C) is evaluated the same as A(B-C), but AB(C-D) is treated
like Ab*(C-D) asif AB isasingle variable’'s name.

Entering or editing atitle
Title

cuesstion_1  “QnTitle” editablefield...

Edit the defaullt title text just as you would edit text in any
database field--click in the field with the pointer, drag to highlight
any text you wish to delete or replace, and then type in the text
you wish to have in the title.

Classtalk QUICK-START Manual
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Notes:

The Question Fields window gives you instant
access to all the hidden details of a question, and to
notes and recommendations that the question’s
creator may have provided to help you use the
question effectively

For every new question you make, you
MUST select a “type” (or use the default
MC).
We strongly recommend that you also
enter...
- -a title (with key words first);
--text for the students to read (Hot text) that
at least describes their choices

It is very helpful to set up useful bins.
We recommend assigning some score to
each bin-- say 1 point for all answer except 5
to 10 points for correct answers.

Feedback is valuable, but time consuming to
write. Add it if you have the time.

Format

n “Format’field  editable pop-

up...
Format is used primarily to let you set up MC
answer bins quickly and eastly. The popup allows
you to select other sets of answers, or you can type
in your own set (e.g.1..9)

TEMPORARY LIMITATION: TT’s are limited to 15
character Tx answers just for the first release.

You can edit the title from either the Qn Screen
window, or from the Qn Fields window.
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Task Field Window
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Setting or changing the Task time

Every Classtalk question or set of questions (“Task”) istimed--i.e
once atask is started, students can work on it for a set amount of
time.

Tim=

o 00

|[ ] Task Time" editable popup...

You can preset the Task timein the “Time” field of the Qn Fields
window by typing in another value, or by selecting avalue from
the popup menu.

Editing the Question “ Prompt”.

Every question has a“ prompt” that appears on the students
screens right next to where they type their answers.

Prampt ” i1 1

Enter your choice: Prompt” field...

Customize any Qn’'s prompt by clicking in the “Prompt” field and
editing the text as desired.

“Hot Text” --text for the students' displays
Every question can include “hot text” which is sent to the student
units and viewed by the students once the task is started.

HatTent ot Text” expandable feedback field ...

Click inthe field and begin typing whatever text you wish the
students to read while they are answering. The “Hot text” field
expands as you add to it, up to a maximum of 4,000 characters
(about 1 full typewritten page).

Question specific Notes & Descriptors

A “Qn Notes’ field is provided to display information to the
instructor that will help him or her use the question effectively in
class. We recommend that you include such information as...

1) Scenario for using the question;

2) Story to tell related to the question;

3) Purpose/value of asking the question

4) Helpful tips & hints related to using the Qn.

The “Descriptors’ fields should include searchable terms that help
identify the Qn, the topic or subject matter, and the context for
using Qnin class.

“Code” field for courseware

Code “ editable “ Code’ field for courseware...

The“Code” field isintended for courseware developers to
provide away to link related questions together in an instructional
framework. Software supporting the use of the* Code” field is
under development.

p. 10

Notes:

“Timer” button

Task time can also be preset from the Qn Screen
window by clicking on the timer button (which
brings up the timer window).You can always
change the task time from the timer window just
before sending the question to your class, or you
can add (or subtracting) time while the task is
being answered.

77 systems-- the prompt only appears when the
students use the ‘Screen editor”. Be sure the
prompt information is redundant or they might
miss it. But don't leave it blank, because its their
only reminder of what to answer from the “Screen
Editor”.

We suggest you use “Hot text” to briefly restate the
question, and enumerate the choices or how the
students should answer. It’s wise to keep hot text
to 9 or fewer lines since longer “HI” takes time to
send, and requires that the students scroll their
displays to see all the text.
HOT « ” .

‘TEIT_I ‘Hot Text” button for instant access to HT...
You can also view & edit the HT directly in it'’s own
window by pressing the “Hot text” button.

You can select & copy “Hot text”in the Task Fields
window, to paste into the Task Screen window.
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“Bins’ categorize each student answer, & individualizethe
feedback to the students.

Each “bin” includes the following fields:
“Range” :delimits which answers are in the “bin”.

Eange . . .

A atypical MC Question “ Bin Range”

For MC Qns, each letter can haveit's own bin, or agroup of |etters
can shareonebin (e.g. “B,E,F")

Fange . .

z.120:3.122 aNuQuestion“Bin Range’

Numeric Qns are binned between minimum and maximum values.
e.g. “2:2" acceptsonly “2" or “2.0...” (any number of zerosis OK

Banne
:—kﬁ ristot77+ aWdor Tx Question “ Bin Range”

Wd and Tx Qn hinslook for an exact match or search for words
within the answer. In this example, “aristotle” or “aristot” with any
other letters at the end would be found anywhere in the answer text.
You can also specify combinations of target words, or multiple
target words.
Fange . .
other Rangesetting for catch-all “ Other” bin...
Every Qn has an “Other” bin to catch unanticipated answers. DO
NOT ATTEMPT TO DELETEIT!
“Color”: color tag identifies students by answer
Cuolar . .

popout menu of bin color choice...s
The “bin color” is used on the class seating chart, in answer lists,
and for the Analysis histogram bar.
“Mark” (e.g. v or x) reminder of significance.
Mlark

[

Thismark is “private’--for your eyes only, to remind you of the
significance of the bin.

“Feedback” text to read after answering;

Feedtack

“Mark” bin, a single character for a reminder.

field for answer-specific feedback.

Feedback (FB) isavailable (if present and enabled) when thetask is
over or, if alowed, immediately after answering (immediate FB)

“Notes’ describes the significance of the bin

field for labels & notes on bin meaning...

Thisfield may be used to label or describe the significance of the
answer bin. For example “forgot to divide by 2" or “used wrong
units.”
“Score” points assigned an answer in this bin.
3

T:ED Score-- 3 char number between -99 and 100

Score for answer (does not have to be an integer)
“Link” field for courseware devel opers.

Permits linking specific answersto related questions. “Link” field
isunder development.

Classtalk QUICK-START Manual p.
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Notes.

Student answers are grouped (categorized) so
that each answer falls into one out of as many as
ten “bins”. You can customize the bins so that a
particular bin contains answers from students
with specific misconceptions or variant points-of-
view. For example, if you want to group together
students answering “A” and “C”, you can list both
in the “Range’, separated by a comma. Other
logical specifiers are available.

Use Option -v to get a nice vV mark

We suggest you provide feedback that encour-
ages the students to rethink their answers so that
they come up with the correct answer themselves,
rather than being told “NO--the correct answer
5.7

We ve found students are more engaged if they
get some credit for any answer (e.g. 1 point), and
more credit if they get the answer partly or
entirely correct.
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Working with the Task Screen

Press this tool-button when you want to see or edit the selected
Qn’'s“Task screen.”

Entering or editing a question title

Question_ 1  Questiontitle editablefield..

Click on thetitle and begin typing-- this will replace the current
title. To edit a portion of thetitle, highlight the portion of text to
be replaced, and type in the new text.

Creating & editing a text region
@ “Text” tool button

Click on the “text” tool button, then “Click & Drag” atext
region rectangle the size of what you want to type in. You will
be able to reshape this region later if you don't get it quite right.

| Helvetica 18 [bold] w | “syle’ popup

You can use any preset style-set (font, size & style) or select or
change specific text attributes including text color form this
“Style-set” popup menu.

Typein the text you want the studentsto see projected on the
TV or LCD screen.

Once you'rein atext region, you can select or edit text just as
you would in adrawing program like MacDraw(tm).
Toresizeatext region...

Click outside of the region until you get an arrow pointer. Then
click_once anywhere in the text region you wish to resize. Little
“handles’ will appear at the four corners of the region. Use the
handles to resize the object. You can also drag a selected text
region just like any graphical object.

Creating and modifying a graphical object
E “Line” tool used to create straight line, and
single or double-ended arrows,

E “Rectangle” tool used to create boxes;

‘Rounded rectangle” tool;

;A “Circle & oval” tool.

Each of these tools makes a graphical object that can be
selected, copied & pasted, resized, or relocated like graphical
objects in drawing programs like MacDraw or ClarisWorks(tm).
Color and line thickness, and position (in front or behind other
objects) can be altered for al of these objects. Shapes (circles,
rectangles etc) have selectable “fill” color and pattern (see
below).

Classtalk QUICK-START Manual
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«  Questions can be quite stimple, or they can be rather
complex. There can be a part that is “projected” for
the whole class to see on a TV or using an overhead
projector & LCD panel. There can be ‘hot text - text
Jor the students to read before answering the
question. And there can be “Feedback ™--text that is
shown privately to students or groups that relates to
the answer they “sent in”. BUT you don't have to
have all of these component parts in every question...
1t’s up to you, the instructor, to decide just what
parts you need and what parts are unnecessary.

«  [fyouve already written out the question in “Hot
text’, copy it from the Task Fields window, and paste
it in a text region in the Task Screen. Youll want to
resize it.

e We recommend you use 36 or 48 point text to ensure
that your students are able to read the screen.
Check out what works best for your display system.

e 7o get white text on a colored or black background,
change the text color to white, and place a colored
rectangle behind the text region.

« Shortcut: You can select a portion (or all) of a text
region to include in the “Hot text” that is sent to the
student units. 7o do this, select the text object, or
highlight the desired text and press G

»  We do not recommend making intricate diagrams
using Classtalk’s tools. They are intended for simple
graphics or to add a missing line or two to an
imported PICT. If you need a top-quality drawing,
use a professional drawing package such as
MacDraw, Canvas, or Clarisworks to create the
drawing. Then copy it into Classtalk using the
clipboard (i.e. Copy & Paste) or the PICT import tool.
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» Changing color & linewidth of objects —Notes:

Pop-out menu of fill patterns for 2D shapes,

@ Pop-out menu of fill color for 2D shapes;

D Pop-out menu of line colors;

g Pop-out menu of line width and arrow heads;

Use one or more of the pop-out menus to change color, fill, line  Resized PICTs may look strange due to uneven
thickness or arrow heads for the selected graphical object. If no doubling (or deleting) of rows or columns of pivels.
object is selected, selecting an attribute sets the default of that ZS best to resize your PICTS before importing

. . em into Classtalk!
attribute for al new objects that you create.

* Inserting & resizinga PICT image
You can paste in any “PICT” format object from other applica
tions or from the scrapbook, using Copy & Paste.

ol » ; ; : e NOTE: QT performance may be poor during the
PICT tool” used to import an entire PICT file Drojection of the task with enlarged or high

. . . . resolution movies unless you have a op-of-the- line
Toresize aPICT object, select it using the Macintosh. Be sure--try out your ovies on a two-
tool, and drag one of the corner “handles’ to reduce or enlarge the Sglr(ee” system before class tomake sure they work
image area. '

* Inserting & runninga MOVIE
You can paste in any “QT” (Quick Time) format movie from other
applications or from the scrapbook, using Copy & Paste.

@ “MOVIE tool” used to import a QT file.

You may have as many astwo QT moviesin a Question Screen.
However

ToresizeaMOVIE object, select it using them

tool, and drag one of the corner “handles’ to reduce or enlarge the
image area.

W [ v JO=——=]a1]1+] "Movie controller...

Movie controls appear in the Task Info Panel.
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Question sets
A “Question Set” is atask with more than one part to be an-

swered. The parts can be interrelated or unrelated. Classtalk
allows you to require that the students answer the partsin a
specific order (called “in order”), or to allow “random access’,
where the students choose from alist of titles the question they
will answer first, second, etc. Only one Task screen can be
projected during a Question Set, so make sure the component
guestions are completely stated either in “Hot text” or on a paper
handout or overhead transparency.

» Anatomy of a Question Set (QS)
All Question Sets have a“Header” which includes the Task
Screen, and QS settings. The “inside” of a Question Set consists
of ordinary questions that have been created or pasted inside.

LIST

T

usethe“ List” tool to see QSsin your taskfile.

In the “list of tasks’ Question Sets may be “ Collapsed” so you
only see the Header title, or they may be “expanded” so you see
the QS header and the titles of all the Qnsin the QS

05

P Fusl Crum a“ collapsed” QS

Clicking on the black triangle expands a collapsed QS, or
collapses an expanded QS.

0S5 w9 Fuel Drum

e the same QS* expanded”

Confidence

» Creating a new Question Set

N
e
w

=

Question Set, or to add anew QS Question within an existing QS.

Use the “New” popup in the New Tasks Panel to create a new

» Question Set settings
At present, the only QS setting is “ Sequencing”. The default
selection is“In order”-- the students don’'t see alist of titles, and
move directly from one question to the next, in order.

sequencing| In order |

Feedback is also provided “in order”.
“Random Access’ allows the students to select questionsto
answer from alist of Qntitles.
QSTimeissetinthe“Header” (theindividual timesfor the
included Qns are ignored). At present, atimeis set for the
duration of the whole QS.

Notes:

« Here's an idea-- start the day off with a “Login-
Quiz” conststing of a Question set with a few short
questions Each student answers the QS after s/he
logs in for the class-- and you get great feedback
on whether theyre ready for today’s lesson!

e Because of network limitations, we recommend
that you keep the number of questions to 10 or
Sewer. The actual limit depends on how much text
is included in the Hot text and feedback fields of
the questions.
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» Assembling QSsfrom existing Qns

LIST

i—|usethe “Task List” to see QSsin ataskfile.
o1—

You can “click & drag” Qnsfrom thelist into any QS on the list
whether the QS is expanded or collapsed. Within an expanded
QS you can drag Qns up or down to change their order, or you
can drag them out of the QS entirely.

Cut & Paste( -c& -v) work for building QSs from tasks
found in other taskfiles.

* Running & Monitoring QSs
Select aQSto run by clicking on its “Header” in the Task List.
Use “Send” to transmit the QS to the student computers. Check
the time, grouping and feedback settingsin the timer window,
and click “Start” to allow the students to begin answering.

* Analyzing Question Set returns
QSs have a special type of binning that allows you to follow
student answering throughout the QS.

~1#5~2#1 27
~] &1~ 2 #1 T Question Set bins

Question set bins group students by their series of answersto al
the questions in the question set. The key shows question number
and bin number for each question in the set, and tallies the
number of students who answered with this set of answers.

This QS-autobinning works for the Classview and the Analysis
graphs of the QS.

To view student performance for an individual Qn within a
QS, locate the Qn'stitle in the “Active Tasks Mode” panel and
select the individual Qn'stitle.

Records of a session (current or past)

the “Records’ mode panel

After you and your class have finished answering a task, having
discussed it and having looked any feedback, it's time for the
task to become history. Starting a new task or clicking “Done”
will automatically move the task from “Active” to “Records’,
i.e. history.
Records of past sessionsare stored in date-stamped “ Session
Files’ in the Session folder for your course.
Each session has a different number: S 1, etc.

* Reviewing Records from past sessions
1) Open apast sessions from the “Files” Menu:

Files->Session  files-=>Open Session file
or open several sessions at once use group open:
Files->Session files>Group  Open Session

2) Select a session to review using the (upper) Records mode-
panel popup menu.

3) Select atask to review using the Task list or (lower) mode
popup menu to. All views & analyses should work just asif you
werein class.

Classtalk QUICK-START Manual
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Notes:

Normally the QS header’s “Task Screen”is projected
when you run a QS. Ifinstead of selecting the
“Header” in the task list, you select one of the
question titles within the QS and press “Send’, you
are presented with a choice:

--Send just the selected Qn, or

--Send the entire QS, but project the selected Qn'’s
“Task Screen” instead of the QS “Task Screen’.

In this example there were two questions in the
question set. Twenty seven students sent in answers
to Qn 1 that fell into Qn 1's 3rd bin, along with
answers to Qn 2 that fell into Qn 2's first bin.
FEighteen students’ answers to Qni fell into the 3rd
bin, but thetr answers to Qn2 all fell in the ist bin (as
did the other 27 students’).

TEMPORARY RESTRICTION: Group open won't
allow you to switch folders. Set the folder using
Open Session.
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Exporting Record data for other uses

Itiseasy to use selected Classtalk Qnsin student evaluations
or grades. The data are readily exported in tab-delimited text
files that can be opened or read by virtually all spreadshest
programs.

Export Setup and Export are on the Files menu.

Export Setup: choose the data fields to export...

1) Decide where you want the column labels;

2) Decide which “label fields’ you need-- we suggest you use
at least student ID and Last Name;

3) Decide which data fields you need;

4) Decide which sets of Qn data to export--data from al the
Qns, or only from selected Qns?

5) Click OK to accept the Export Settings;

Export: Select the Qns or Sessions you want to include in the

export file, and then select “ Export”. Choose a useful name &
destination folder thefile.
Click SAVE to create the export file.

Collected Sessions (CSs)

Classtalk’s “ Collected Sessions” are designed to help you keep

track of each student’s progress and participationin class. Use

a collected session to gather_in onefile, students' answersto

key questionsin a curriculum unit or over atwo or three week

period. Each CS also includes a“ StudentPerformance”

summary (which looks like a QS) that contains attendance,

participation and score summaries for each individual student.

Building a Collected Session

1) Create anew collected session-- use the menu:

Files->Collected Session->New Collected Session

2) Open one or more regular sessions that contain tasks you

wish to include in the collected session.

Files->Session File ->Open Session File, or

Files->Session File ->Group Open Session File.

3) Select the question or questions from the Task List that you

wish toinclude in the CS.

4) Use “Copy with Answers’ to copy these tasks:
(Edit->Copy with Answersor  -1)

5) Use “Pasteto CS’ to paste these tasks into the CS: (Edit-

>Pasteto CSor -2). Your view will be shifted to thelist of

itemsin the CS, so you can verify that the tasks have been

copied, or you can look at the Session summary set.

To add additional items select the appropriate session and

repeat form step 3.

Using CS*“ StudentPerformance” Summary

Individual student performance summaries are calculated as

you build aCS. All data are normalized so the maximum value

isaways one.

Attendance: proportion of sessions the student logged in out

of total number of possible sessions.

Participation: proportion of Qns answered out of the total

number of questions sent to that student.

If you have made a point to set “scores” for your
questions, this may be the only data field you need.
Otherwise you will have to export answer or bin#
and asstgn useful scores within your spreadsheet..

Once created, you can open this file with a
spreadsheet program such as Excel(tm) or Claris
Works(tm), or you can open it with a text editor,
select & copy the data, and paste it into a preexist-
ing spreadsheet.

In “Room” classview CS data are displayed
relative to a particular sesston’s seating chart. You
can set the reference seating chart to whatever
session you wish.

(under Files->Collected Session->Set Seating
Chart)

WARNING: for a large class, a collected session
can consume a lot of memory. Do not plan to put a
whole semester’s data in one CS. Setting the
preferred memory for the classtalk application to a
higher value helps alleviate memory limitations.

BE PATIENT-- it takes a while to calculate and
update the Performance data, so the paste may be
very slow.

The Performance summaries are designed to
separate attendance, performance and score
variable. Note that Attendance doesn't affect
Participation and neither Attendance or Participa-
tion affects Score.

If you want a combined indicator, just multiply
the two components for each student.

TEMP. CONSTRAINT: You will have to set up
your own bins of Student Performance. This a

spectal type of data-- use numeric ranges e.g. 1.1,
.85:1,.75:.85, etc.
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Notes:

Quitting & Resuming
When you finish using Classtalk in a particular class, you should .

quit the program:

1) select Files->Quit from the main menu,

2) (optional) check which files you do or do not wish to update or
save on disk,

You may want to get into the habit of exporting
your class’ scores for a participation grade, or
you might add key questions to a Collected
session. Just before shutting down is a good time
to do this sort of “house keeping”.

3) Use“Save & Quit” to save what you marked.

Use “Suspend” if you want to continue it later.

Use“Don’'t Save” to abandon the session.

Recovering from Crashes

Someday Classtalk may crash during one of your classes, but be

assured thisis not as disastrous as it seems. Classtalk writes

critical information to disk every few seconds; login information,

answers etc. are all saved in temporary files that can be used to

reconstruct your session. If the Classtalk program “hangs up” or

“freezes’ ,you should reboot your computer, turn the network

adapter off and on, and double-click on the classfile again. .
Classtalk will appear to open normally, but will ask you if you

want to resume the suspended session. The answer is“Yes’!

When you turn the Network Adapter off, the
network adapter forgets who is logged in.
Classtalk has to give this information back to the
network adapter. You will be prompted to relogin
students on the 77s. Choose resume and your
students will be relogged in as it nothing
happened.
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Using Classtalk in your Classroom Notes.
Getting your class*” psyched” for Classtalk

(what to do before you use Classtalk in class)

Experienced Classtalk user find that it is helpful to discuss how
they will use the system to enhance teaching and learning and
improve the classroom atmosphere. We suggest you emphasize
the value to the students:

--participation improves learning

--answering questionsis challenging & fun

--Classtalk helps the teacher know what to teach.

We also recommend that you provide a small (grade) incentive for
participation with Classtalk. With no incentive, some students may
drift into nonparticipation.

The day before you start using Classtalk, go over with your
students what they will see and do as they use Classtalk system.
--Explain how they will connect to the network before class and
disconnect after classis over.

--Show them (with overhead slides) how to login & register, and
how to answer questions individually and in groups.

«  Until you get used to the routine, you may wish to
Hardware & deployment have a student assist you in these processes.
Give some thought ahead of time to how you will deploy and
undeploy the Classtalk system. You will not want to spend more
than about 2 minutes setting up or taking down the system.

Starting up Classtalk
1) Connect components: Cable the computer to the network,
hook up the display system, plug in the power cords;
2) power on (it's helpful to have a master plugstrip) Turn on the
computer, the network & other hardware such a scan converter or
LCD;
3) set out the Student computer s where the students can get
them and return them easily;
4) start up the Classtalk application (from the classfile if you
have one). Open Login (allow new studentsiif it's the first time or
two). Open any taskfiles you have pre-prepared.

Finishing up a Classtalk class
Here are some things to do that will make your life easier at the
end of class:
1) remind your students how to disconnect and return their
computers
2) attendance and participation? Export at least one task to keep
as arecord of participation or add a key task to a Collected
Session that you' re maintaining for the purpose. Copy the file to
diskette if you won't have access to the Mac.
3) Quit CT & Shut down Mac
4) Turn all power off before disconnecting;
5) Disconnect & put away the components.
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Loggingin & Registering a Class
All student users must have an established Classtalk “account”
before they can use the system.

There are two ways to set up the class' accounts:

1) Each student “Registers’ from his/her student computer on the
first time she uses Classtalk, or

2) Theinstructor preregisters the students by importing a“roll” file
containing the essential information on each (i.e. LastName,
FirstName, Studentl D, Handle, and Password.)

Most instructor use method 1). Hereis a reasonable way to do it.
in college classes...

» Day beforefirst use: Instruct the students what to do to register &
login. Use overheads. Explain what “ Student| DS’ and “Handles’
are to be used.

* First week: “Allow new Students’ when you open login. Tell
them “Register ONLY thefirst time. Memorize your Handle &
Password!”

» Second day on: Bring aprinted list of Student Handles and
passwords, because several students will forget each day for at
least aweek.

Usually all students will be registerred by the end of the first week,
and you should not “Allow new students’ after that.

Classtalk “ Cycle of learning”,(15-20 min)
There are many ways to use Classtalk, and many reasons to ask
guestionsin class. Here is a generalized “cycle” for incorporating
Socratic questioning in your lectures and lessons.
1. " Anticipatory" Question (or login quiz):
Use a humorous and/or student-related problem or “Puzzler” to
motivate student interest in the topic you’ re about to discuss.
Students should receive asmall (grade) incentive for any answer.
2. Motivating the L esson
A good “Anticipatory” question will split the class with significant
numbers of different answers. Without giving away your prefer-
ence, the Class should puzzle over their answers, and brainstorm to
identify other possible Qns & As
3. Mini-Lesson (8-12 min)
Your turn to talk & teach. You might present...
--What isthe Problem?
--Relevant background
--Solving the Problem
--Broad & /or Specific Implications
4. Follow-up Question
Now it'stime to test your students' understanding and application
of the concepts just covered. Use another question, maybe an
extension of Qn 1.
Mazur’s Peer-instruction method works well here.
5. Lesson Reprise
Your turn again...
--recap the concepts
--go over theimplications & applications to real-life problems or
situations.
Repeat the cycle for the next related topic.

Notes.

Both Student ID and Handle must be unique for
each student. For Handles, we suggest you have
your students use their nicknames with added
characters to make them unique (e.g. ‘JOHN!!")
Handles are always uppercase.
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Managing task, class and session files
You will be using lots of taskfiles, and creating many sessionfiles
asyou use Classtalk. Here are some suggestions that may help you
keep your files useful and in order...
» use meaningful file names that will help you remember what isin
them from year to year;
keep al the files you need for one coursein one folder labeled
with the course name...
e.g. Phys104’ 95 (folder) might contain: Phys104' 95 (classfile), SF
for Phys104' 95 (folder containing sessions and collected sessions),
*104 M echanics Tasks (folder containing mechanics taskfiles), as
well as copies of the files Classtalk needs: Instructors List,
Rm.120.config (the room configuration), Task template, and Quick
Qns.
» organize tasksinto taskfiles according to sensible topical or
pedagogical content;
» Keep up-to-date backup copies of all task, class, & session fileson
separate diskettes.
Tipsfrom Classtalk users...
WE've watched Classtalk in action in many classrooms. Here are
some tips that will help you achieve the same success that our best
usersenjoy in their own classes...

Makeit Relevant-- It'simportant that your students feel the value
of answering Classtalk Questions.If they don’t sense they’re
gaining something, they are likely to become reluctant participants
once the novelty has worn off.

* Makeit apositive experience-- Don't use Classtalk to embarrass
or denigrate individual s or groups.

» Begin Login before class begins--it savestime! Get your students
in the habit of logging as soon as they get to class. This conserves
classtime to use for teaching & learning;

* UseaLogin-Question or Question Set-- A Qn or QS concurrent
with login will focus your students on the subject of the day (Also
it'sgreat for checking that they understood their homework
assignment);

» Get your students used to answering questions-- Too little use

makes it harder to succeed. It works well to use Classtalk three or

more times aweek if you have good questions. But remember that

Classtalk isjust one of your teaching tools-- use it only when you

and your students benefit. Don't feel you have to use Classtalk in

every lesson;

Group collaboration is GREAT-- Encourage your students to

share a calculator/computer and collaborate on answers, at least for

some questions;

Establish clear-cut ground rules-- Signal when talking &

collaboration are OK, and when you expect quiet, and/or indi-

vidual answers;

» Beprepared for surprises-- Plan to adapt your lesson on-the-fly

to take advantage of your "inside line". You're bound to meet

unexpected responses.

Notes:

We suggest that you strive to use meaningful Task
names within your taskfile. This makes it much
easter to find the Qns you want.

We like our taskfile folder to be at the top of the
list in the file selector. The asterisk before the
name puts it in front.




